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Copyright 

Copyright © 1998 - 2003 Torlesse Systems Pty Ltd  (ACN 003 291 085).  All rights 
reserved. 

Palm, the Palm Logo, Palm Computing, HotSync, and Graffiti are registered 
trademarks, and Palm, Palm III, Palm V, Palm VII, PalmPilot, Palm OS, and the 
PalmPilot logo are trademarks of Palm Computing, Inc. All other brands and product 
names are trademarks and registered trademarks of their respective holders. 

Disclaimer and Limitation of Liability 

Torlesse Systems Pty Ltd assumes no responsibility for any damage or loss resulting 
from the use of this User Manual. 

Torlesse Systems Pty Ltd assumes no responsibility for any loss or claims by third 
parties that may arise through the use of the software application known as 
WardWatch.  Torlesse Systems Pty Ltd assumes no responsibility for any damages, 
loss, injury, or death caused by deletion or corruption of data caused by malfunction, or 
failure of WardWatch.  Be sure to protect patient records against theft and backup 
patient records onto other media to protect against data loss. 

Important 

Please read the Software User License Agreement found in the appendices of 
this document.  Using any part of the software application, WardWatch, 
indicates that you accept the terms of the Software User License Agreement. 
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Getting Started 

Introduction 

Welcome to WardWatch.  WardWatch has been designed specifically for the Palm 
organizer to aid medical staff involved in ward rounds.  It is intended to record 
investigations, medications and dosages, and consultations that are requested by the 
senior Consultant (Specialist) or Registrar during Ward round examinations and to 
record the results of these investigations for recall in later rounds and on the desktop. 

WardWatch’s features include: 

• Ability to record basic patient details: name, hospital record number, DOB, sex, 
admission date, ward, room and bed, consultant, notes, diagnosis, and allergies. 

• Automatic calculation of patients’ age that also caters for Paediatrics. 
• Easy tracking of patient records with the ability to group and order records by 

various methods, including ward, consultant (specialist), record number and 
others. 

• Tracking of patient investigations, medications, lab results, notes, and 
consultations, with the ability to mark the status and results of each these events 
(items).  Icons are used to quickly identify the category and status of events. 

• Sorting of patient events (items), including the generation of “to do” lists. 
• Easy navigation of patient records for daily review. 
• Transfer patient records between Palm organizers using infrared 
• Printing of patient records and to do lists using Stevens Creeks PalmPrint 

application to many of the infrared enabled printers. 
• Backup and recovery of the patient records during the HotSync process. 
• Context specific autofill in events detail screen and clearing of autofill DB. 
• PatientInfo popup for fast access to crucial patient information on patient 

screens. 
• On screen access to patient sorting and display options on patients list 
• Filtering of events with status and type in Events and Patient View screens 
• One tap change of event status from Patient View screen 
• Ability to delete of entire categories of patient records. 
• Password protection of patient records 
• Requires PalmOS 2.0/3.0/4.0/5.0 
 

Chapter 

1 
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WardWatch Desktop’s features include 

• Hotsync of patient and event records with Windows desktop companion  
• Patient view or event views 
• Creation, modification and deletion of patient records and associated events on 

the desktop.  
• Sorting of patient records on any field headers; name, age, sex, MRN, bed, ward, 

and consultant, and diagnosis.  
• Sorting of patient event records on fields; date, type, status, test, result, note, 

created  
• Lookup function for searching for a patient's record.  
• Printing of selected patients and events to desktop printer.  
• Multiple palm user capabilities.  
• Requires Windows 98/Me/NT4/2K/XP and Palm Desktop 3.0 or greater 
 
 

New in Version 3.1 
 

Integration capabilities with other patient record systems. 

• Ability to export patient records to a file for exchange with other doctors or for the 
purpose of archiving patient records that are current not used. 

• Import Patient records from HOSPAS patient record system 
• Allow third party developers to integrate WardWatch with other patient record 

management systems in use. 
 

Download and Installation of WardWatch 

If you haven’t done so already visit http://www.torlesse.com/wardwatch to obtain the 
latest version of WardWatch and download it to your desktop computer.  Choose the 
compressed format suitable for your computer. 

WardWatch can be downloaded in the following formats. 

• As a self-installing executable which includes the MS Windows Hotsync 
conduit with the desktop companion (WardWatch Desktop).  This install is for 
MS Windows (98, Me, NT, 2000, XP) only.   

• As an archive file that requires manual install.  Archive file formats are available 
for either Windows (zip) or macintosh (sit). 

For MS Windows use the self-installing executable (WardWatch.exe).  Simply 
download this program and run it.  This program contains the WardWatch application 
that runs on the Palm, the Hotsync Conduit and the Desktop companion.  During 
installation the WardWatch.prc file is loaded into the install directory ready for next 
palm hotsync and the WardWatch conduit is installed into the Hotsync manager.  The 
installation program will ask for an install location.  The default is C:\Program 

http://www.torlesse.com/pilot/wardwatch


WARDWATCH USER MANUAL  © 1998 - 2003 TORLESSE SYSTEMS PTY LTD 

   1-3

Files\WardWatch.  WardWatch Desktop top can be found under Start > Programs > 
WardWatch > WardWatch Desktop. 
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For MacIntosh users (or Windows users not requiring the hotsync conduit) there are 
WardWatch archive files to download (WardWatch.sit and WatchWatch.zip).  There 
are four separate files you will find in the archive. 

• WardWatch.prc – the WardWatch application. 
• WW_Manual.pdf – this manual 
• WW_License.txt – the software license  
• WW_ReleaseNotes.txt – the release notes for this version 
 

To install WardWatch.prc follow the instructions in Chapter 3 of the Palm V Handbook, 
Chapter 4 of the Basic Handbook (For the Palm III Organizer) or Chapter 11 of the 
Palm Pilot Handbook (for earlier Palms).  These chapters describe using the Install 
Tool to install add-on applications. 

Before using WardWatch Desktop  

Before you can use WardWatch Desktop you need to start WardWatch on the Palm, 
accept the license agreement and perform another Hotsync.  This will create the basic 
data files on the desktop 

Starting WardWatch on the Palm 

 

After installing WardWatch, locate the WardWatch 
icon on the Palm and tap on it.  This will start 
WardWatch for the first time. 

 

The first screen you are presented with reminds you 
that this is a 30 day evaluation copy.  Tap on “I 
Accept” to accept the license agreement and 
continue.  You must read the software license in the 
appendices and make sure you agree to the terms 
and conditions.  If you do not agree with the software 
license you must delete WardWatch from you Palm 
Organizer and PC. 
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Sample Patient Record 

When you start WardWatch for the first time a sample patient is created.  This patient 
is shown below.  The patient is fictitious and the events are for example only. 

         

Patients screen Patient View screen Event Detail screen 

Tapping on the patient record “Robertson, Jeff 59y” in the Patients screen takes you 
to the Patient View for that patient.  If you tap on an event (for example Fbc – Full 
Blood Count) you are taken to the event details screen.  From the Patient View 
screen you can also tap on the individual note icons for each event to be taken directly 
to the notes for that event. 

Tapping the New Event button in the patient view screen allows you to create a new 
event.  Tapping the Edit button at the top of the Patient View screen takes you to the 
Update Patient screen – from here you can delete the sample patient.  The icons at 
the top of the patient view screen allow you to go to the unstructured notes screen for 
this patient, or allow you to beam this patient to another Palm organizer.  

Loading the Registration Key 

If you have purchased WardWatch you will have received a Registration Key to unlock 
the evaluation version.  Enter the complete Registration Key from the Patients screen 
by choosing the Menu Options then Registration Key.  Tap OK and you will receive 
confirmation that the key has been stored. 

         

IMPORTANT:  Keep your registration key in a safe place; you may need it if you need 
to recover WardWatch from backup.  You may also need it for technical support and 
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when obtaining upgrades.  Your registration key is unique and identifies your Palm 
Organizer as a valid user of WardWatch. 

Loading an upgrade key  

If you are purchase an upgrade to WardWatch you will need to have the original key 
loaded before loading the upgrade key.  After loading the original key simply delete the 
######### in the “Key:” field and enter the upgrade key into the Key: field and click ok.  
Hotsyncing will cause the desktop companion to be registered 

       

Setting up Patient Categories 

Before entering patient records into WardWatch, you may want to decided how you 
will use the patient categories.  Full details on how/why to do this are explained in 
Customization and Preferences section. 

The use of categories is the similar to the categories in the Palm address book 
application.  Categories are also used for beaming or printing of groups of patient 
records. 

Typical uses of the categories are as follows 

• To differentiate between in and out patients (eg Out Patients,  Clinic 21, Clinic 
A) 

• To break patients into different wards (eg Ward 12, Ward B, South Wing) 
• To differentiate patients admitted under different consultants or specialists (eg 

Johnson, Simpson, Carson,) 
 

You will need to experiment to decide which categories make the most sense for your 
use of WardWatch. 
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Ward Rounds 

Patients (List) screen 

 
 
The Search field may be 
used to find patients by 
entered their surname.  
This feature is only 
available when you patients 
are sorted by Surname. 

This is the main screen of WardWatch.  It shows a 
list of all the patients in the current category.  By 
default, it also shows the patients age and sex, and 
the consultant to whom this patient belongs.  By 
adjusting the preferences you change what details 
are shown on the Patients screen. 
Tapping on the Consultant pulldown will give you 
the option of changing what is displayed in the right 
hand column.  You have the option of Consultant, 
Category, Ward, Room/Bed, MRN, Diagnosis and 
None. 
 
Tapping on the Sort pulldown gives you different 
options to sort the patient list.  The options include 
Patient, Consultant & Patient, Consultant & Room, 
Ward, Room & Bed.   Note that you can only 
search for a patient when the patients are sorted by 
the patients’ names. 
 
When the number of patients in the patient list 
exceeds the screen size the buttons  will appear 
in the bottom right corner.  Tapping these will move 
the screen up or down a single patient.  Pressing 
the hard plastic up/down buttons on the Palm 
Organizer will also scroll the patient list up or down 
an entire page. 

 

Chapter 

2222 
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Creating a Patient Record 

Before doing your ward round it is necessary to load your patient list into WardWatch.  
In version 3.0 of WardWatch you will be able to do this from the Windows Desktop. 

         

Tap the New button on the Patients screen to bring up a blank Patient record.   

The cursor will be flashing in the Lastname field.  Enter the Patient’s surname then 
use either the Next Field graffiti stroke ( ) or tap to move to the First Name field.  Fill 
in each of the fields on this screen. 

After filling in all the details tap on Add.  If you wish to enter another patient’s details 
you can tap on Add & New and immediately start entering details for the next patient. 

 

Additional details for the Diagnosis, Allergies and 
Notes can be entered by tapping on the [..] icon next 
to each of these fields 

 
Notes 

• To enter the Date of Birth first tap on the DoB field, and you will be prompted for 
the Year of Birth.  You then will be taken to a calendar for the year the patient was 
born. 

• Tap on either M or F for the Sex field 

• The fields Ward, Consultant and GP are Auto-fill fields.  This means WardWatch 
will remember previous names entered and attempt to guess the name based on 
the first few characters you enter. 

• You need to choose how you will use the categories for your patients.  The Unfiled 
field at the top right of the screen is the category.  Generally you would use the 
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categories for either the Ward (default) or Consultant.  Depending on which of 
these you choose you can leave the corresponding field (either Consultant or 
Ward) blank.   

• If you have entered the name of someone and you have their phone number in the 
Address book you can add the phone number to the field in WardWatch by going 
to the Menu Options then Phone Lookup. 

Patient View 

Once you have created a patient tapping on Add will take you to the Patient View 
screen, shown below.  From here you can add further details by tapping on the icons 
below or tap Patients to be taken back to the Patients screen.  The New Event button 
is used for patient events and is described later. 

 

The top three lines of the Patient View is a  
summary or the patient’s details.  Tapping anywhere 
in these lines will display the Patient Info Popup.  
The summary show the patient’s name, age, sex.  
On the second line the Day: indicates the number of 
days since admission, the #: is the patient’s hospital 
number, and Cn: shows the consultant.  On the third 
line is the Date of Birth, the Diagnosis (Dx:).   

 
 
In the top right corner tap on; 

 to beam the patient to another Palm Organizer.  This is described later. 

 to go the unstructured notes shown below. 

[edit] to update the patients details 

 tap anyway in the patient header to go to the info popup. 

 tap on the face icon to bring up the Patient Info popup in the notes page. 



WARDWATCH USER MANUAL  © 1998 - 2003 TORLESSE SYSTEMS PTY LTD 

 2-4

 

Tapping anywhere in the patient summary will popup the Patient Info screen. 

 

 

From this screen, you can now enter events (items) for the patient.  If you wish, the 
admission notes can be recorded as the first event. 
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Admission Notes 

If you need to record detailed admission notes, the first event that is created for a 
patient can be the Admission note.  Tap on New Event in the Patient View to create 
an event, tap on the event type and change it to Note, tap on the status and change it 
to No Status.  You can now record your data in the Notes field, having first written 
Admission in the Test/Drug field.  If the notes are more than three lines tap on the  
icon to go to a full screen for entering detailed notes for the patient. 

 

 

In the second copy of the Patient View screen above, the Admission note event is 
shown.  Tap on the Admission note event to be taken to the event details screen.  
Alternately tap on the note icon ( ) to taken to the event notes. 

Discharge Planning notes can be recorded in the same way as the admission notes. 
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The Round 

Once the patients details (and the optional admission notes) have been entered for 
each of your patients you are ready for a ward round with your Consultant (Specialist). 

Individual Patient Records 

Tapping on a patient in the Patients list will bring up the events (items) for that patient. 

 

The main roll of WardWatch during the round is to 
record the investigations, consultations, and 
medication changes as requested by the consultant 
(and/or registrar) thereby creating yourself a “to do” 
list.  Tap the New Event button on the Patient View 
screen. 

 

 

 
Tapping New Event will popup the event type – 
choose this and you will be taken to the event details 
screen.  Here you need to choose the event status 
(ToDo default).  The Test/Drug field has context 
specific autocomplete.  It will attempt to guess the 
value you are typing based on previous entries of the 
same event type.  
 

 
Hint:  You can jump between patient records without returning to the Patients screen 
by using the  buttons at the bottom next to the patients button.    These buttons are 
only shown if there are patients records to jump to. 
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Event Types and Status 

The following table show the icons used to indicate the event types and status.  If you 
rename the event types the same icon will still be displayed for that event type. 

Type Status 
0            Unfiled        No Status 

1        Medication     ToDo 

2        Pathology     In Progress 

3        Radiology     Normal 

4        Nuclear Medicine     Abnormal 

5        Consult     Start 

6        Problem     End 

7        Note     Unknown 
     Done 

 
Review and Follow Up 

After the ward round it is then necessary to organize the investigations requested from 
the consultant.  From the Patients screen you can view the events for all patients by 
tapping on Events.  In this screen you can filter events with any specific status of any 
type  – for example all the InProgress Radiology events. 

All Events 

The Events screen shows all the events for all patients.  The two pull down lists on the 
top line of the Events screen are used to filter the events.  The first pull down list is for 
the event status and the second is the type. 

      

You can sort the events by date or by patient.  Tapping on an event will take you to the 
details of that event  
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Patient View 

 
 

It is possible to filter the events for individual patients.  
By tapping on the Status and the Type field you can 
choose to only display specific events for this patient.  
For instance all the ToDo events. 

 
 

By tapping on the status for the patient it is possible 
to change the status without going into the details for 
that event.  The date can be changed in a similar 
way by tapping on the date field. 

The (next) Round 

 
 

Sorting Patients 
 
Tapping on the Sort field in the bottom right will bring 
up the list of options for sorting the patients.  When 
patients are sorted alphabetically the Search field 
can be used to locate a patient using their surname. 

 

Displaying Details 
 
Tapping on the Consultant field in the top right will 
bring up the list of options showing which information 
for the patient can be displayed in the right hand 
column. 

 



WARDWATCH USER MANUAL  © 1998 - 2003 TORLESSE SYSTEMS PTY LTD 

 2-9

Password Protection 

To provide privacy and protect your patient records from unwanted access a password 
can be set on WardWatch.  This password will need to entered when ever WardWatch 
is invoked.  The padlock icon on the Patients screen will show as locked or unlock to 
indicate if the password is set or not.  Tapping on the padlock will allow you to set, 
change or clear the password. 

 

 

Terminology 

Events or Patient Events:  An event (or patient event) is any investigation, dosage, 
consult, or other items that you have recorded for a patient.  Events are listed in the 
Patient View screen in chronological order. 

Event Types:  Each event is a member of a single Event Type.  WardWatch comes 
with the following event types:  Unfiled, Medication, Pathology, Radiology, Nuclear 
Med, Consult, Problem, and Note.  You may customize WardWatch by changing 
these names or adding your own event types. 

Patient’s Age 

Whenever the age of the patient is displayed the following conventions are used. 

Patient’s Age Display Example 
Less than 14 days as days 6d 
Less than 20 weeks   
(and more than 14 days) 

as weeks 11w 

Less than 24 months   
(and more than 20 weeks) 

as months 14m 

More than 2 years as years 35y 
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Screen Navigation 

The diagram below shows the main navigation around WardWatch. 
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IR Beaming and Printing 

IR Beaming 

WardWatch supports the hand over of patients to other medical staff through the 
Infrared beaming capabilities of the Palm Organizers.  Infrared beaming is supported 
in Palm III Organizers and later models.  The Infrared Port (IR) is located on the top of 
the Palm. 

Custom Categories: When patient records are beamed the custom patient categories 
and custom event categories are also beamed.  The maximum number of custom 
categories  allowed by the Palm OS is 15.  If the number of unique categories on the 
sending and receiving Palm Organizers is greater than 15 some records may be 
placed in the Unfiled category. 

 

By default patient records received by IR beaming 
are placed in the same category as they were in the 
sending Palm.  If necessary the Patient Category is 
created.  Instead you may choose to receive the 
patient records to the currently selected category, or 
to the Unfiled category. 

 

Beaming a Single Patient 

From the Patients screen, tap on the patient you wish to beam.  Once in the Patient 
View for that patient you can either tap on the beam icon ( ) in the top right corner or 
go to the menu Patient – Beam (/B).  

             

Chapter 

3333 
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Hint:  Make sure the IR port of the Palm Organizer is pointing at the IR port of the 
other device (ie top of one pointing to the top of the other).  The Palm Organizers must 
be at least five centimetres apart and no more than one metre.  The path between the 
organizers must be clear of obstacles.  

Beaming a Category of Patients 

    

To beam a complete 
category of patients.  
From the Patients 
screen select the 
category you wish to 
beam, then go to the 
Category menu and tap 
Beam. Or simply tap on 
the icon ( ). 

 

IR Printing 

IR Printing requires the PalmPrint application from Stevens Creek.  This application 
can be found at http://www.stevenscreek.com/pilot/palmprint.shtml.  You may down 
load an evaluation copy to trial the printing facility. 

Make sure you configure PalmPrint to work with your printer before attempting to print.  
Please refer to the PalmPrint documentation. 

Once PalmPrint is installed, printing of patient records is performed in a similar fashion 
to the beaming of records.  To print a single patient, go into the Patient View screen 
for that patient and go to the menu Patient – Print.   To print a category of patients, 
select the category in the Patients screen, and go to the menu Category – Print. 

http://www.stevenscreek.com/pilot/palmprint.shtml
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Note: You must have PalmPrint set with a width of at least 66 characters per 
line.  Otherwise WardWatch will alert you that the page is too narrow. 

 
----------------------------------------------------------------- 
             WardWatch v2.5 Patient Detail Report 
                Printed on 2 Aug 2001 at 1:02 pm 
                        Printed for POSE 
----------------------------------------------------------------- 
 
Name:       Robertson, Jeff                  Sex:   Male 
DOB:        5 Mar 1942                       Age:   57 
Record #:   123-456                          Day:   4 
Consultant: Johnson                          Ward: 
Category:   Unfiled                          Bed:   C2.12 
GP:         Phillips 9234 2344               Admit: 29/7/99 
 
Diagnosis:  Osteomyelitis 
Allergies:  Shellfish 
Notes:      This is an unstructured area for any patient detail- 
            s you may wish to record 
 
----------------------------------------------------------------- 
Date     Time     Category        Status 
----------------------------------------------------------------- 
31/7/99  12:00 am Consult         Done 
    Dental 
----------------------------------------------------------------- 
31/7/99  12:00 am Nuclear Med     Abnormal 
    Gallium scan : up take R. mandible + T10 
----------------------------------------------------------------- 
31/7/99  12:00 am Radiology       To Do 
    OPG 
----------------------------------------------------------------- 
30/7/99  12:00 am Pathology       In Progress 
    blood cultures 
----------------------------------------------------------------- 
30/7/99  12:00 am Pathology       Abnormal 
    Fbc (CBC) : 16.4/126/369 
    Notes: left shift and toxic change 
----------------------------------------------------------------- 
30/7/99  12:00 am Medication      Start 
    Metronidazole : 500mg tds 
----------------------------------------------------------------- 
30/7/99  12:00 am Radiology       Abnormal 
    thoracic spine : T6-L1 # !! 
----------------------------------------------------------------- 
29/7/99  12:00 am Note            No Status 
    Admission 
    Notes: - chronic alcohol abuse 
           - appears malnourished 
----------------------------------------------------------------- 
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Printing All Events (Todo lists) 

IR Printing is also available from the Events screen.  Select the filers you require.  For 
example status of “ToDo”  and event category of “All”.  Then go to the menu Events – 
Print. 

----------------------------------------------------------------- 
          WardWatch v2.5 Patient Event Summary Report 
                Printed on 2 Aug 2001 at 1:06 pm 
                    Category: All  Status: All 
                        Printed for POSE 
----------------------------------------------------------------- 
 
 
----------------------------------------------------------------- 
Date     Time      Category        Status 
----------------------------------------------------------------- 
29/6/99  12:00 am  Consult         Done 
    Robertson, Jeff    123-456    Bed: C2.12 
    Dental 
----------------------------------------------------------------- 
29/6/99  12:00 am Nuclear Med     Abnormal 
    Robertson, Jeff    123-456    Bed: C2.12 
    Gallium scan : up take R. mandible + T10 
----------------------------------------------------------------- 
29/6/99  12:00 am Radiology       To Do 
    Robertson, Jeff    123-456    Bed: C2.12 
    OPG 
----------------------------------------------------------------- 
28/6/99  12:00 am Pathology       In Progress 
    Robertson, Jeff    123-456    Bed: C2.12 
    blood cultures 
----------------------------------------------------------------- 
28/6/99  12:00 am Pathology       Abnormal 
    Robertson, Jeff    123-456    Bed: C2.12 
    Fbc (CBC) : 16.4/126/369 
    Notes: left shift and toxic change 
----------------------------------------------------------------- 
28/6/99  12:00 am Medication      Start 
    Robertson, Jeff    123-456    Bed: C2.12 
    Metronidazole : 500mg tds 
----------------------------------------------------------------- 
28/6/99  12:00 am Radiology       Abnormal 
    Robertson, Jeff    123-456    Bed: C2.12 
    thoracic spine : T6-L1 # !! 
----------------------------------------------------------------- 
27/6/99  12:00 am Note            No Status 
    Robertson, Jeff    123-456    Bed: C2.12 
    Admission 
    Notes: - chronic alcohol abuse 
           - appears malnourished 
----------------------------------------------------------------- 
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WardWatch Desktop 

Overview 

In order to access or add patient records on the desktop you must first hotsync 
your palm to install WardWatch.  You then need to start WardWatch on the Palm 
and accept the license conditions then hotsync again.  This will cause the initial 
data files and the sample patient to be created on the desktop. 

Desktop consists of two views.  The Patient List View and the Events List View.  
You can switch between these views by clicking on the Patients and Events tabs 
at the top left.  For more details see Screen Layout and Shortcuts 

The registration key you are supplied with when you purchased WardWatch will 
activate the Palm and if you paid for the desktop component it will activate the 
desktop also.  The registration key is always entered on the Palm as covered in 
getting started. 

Selecting a User 

 

Like Palm Desktop, WardWatch desktop has a drop down box at the top right of 
the screen that lets you choose a Palm user. The WardWatch data for the 
selected user is displayed and edited in WardWatch Desktop. 

Chapter 
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The user dropdown list also indicates if this user is registered to use the desktop 
companion.  Registration is performed by purchasing WardWatch and entering 
the registration key through WardWatch on the Palm.   

Note if you only purchased WardWatch Palm Application and not the desktop 
companion the desktop will indicate it is unregistered 

Screen Layout and Shortcuts 

 

WardWatch desktop shows lists of patients or events on the left side of the 
screen. To change between showing lists of patients or events, click the 
‘Patients’ or ‘Events’ tab at the top of the left side of the screen. 

The right side of the screen shows details about the patient or event selected on 
the left side of the screen. If a patient is selected on the left side of the screen, 
the events for the patient will be displayed in the bottom half of the right side of 
the screen. 

Any column in a table can be sorted on by clicking the title of the column. By 
clicking the title of a column again, the sort will swap between ascending and 
descending. Tables have drop down boxes above them that allow you to filter 
which patients or events are displayed. 

If you double click on an item in a list or on the details of a patient or event, a 
screen will pop up to allow you to edit the details you double clicked on. This is 
the same as clicking the ‘Edit’ button after selecting a patient or event in a list. 

Pressing the ‘Delete’ key on the keyboard allows you to delete the selected 
patients or events in a table.  
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Pressing Ctrl+N will bring up the dialog box to create a new patient and Ctrl+E 
will create a new event for the current patient 

Categories 

Patient Categories and Event Types can only be edited on the Palm.  Edit these 
on the Palm and Hotsync to make these categories and types available on the 
desktop. 

On the desktop companion you can restrict the view to only see those patients or 
events in a certain category. 

Saving 

When you exit WardWatch Desktop or press the Hotsync button on your Palm, 
WardWatch saves all your most recent changes. You may also choose File > 
Save to force changes to be saved at any time.  

During a Hotsync, WardWatch desktop is disabled - you cannot use it until the 
Hotsync is complete. 

Note that if a Patient’s details or an event record has been changed on both the 
desktop and the Palm, then the Palm record will overwrite the desktop.  You will 
be informed of this in the Hotsync log. 

Reverting 

If changes are made and you need to revert to the last saved copy of the patient 
records choose File > Revert.  This is particularly useful if the wrong patient 
records were imported. 

Printing 

Select a patient and click on print.  The patient will be printed as below. 
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Exporting, Importing and Archiving Patient Records   

Exporting is performed by selecting a group of patients and then clicking the 
Export button.  For example from the categories list choose “Ward 3” then click 
on the first patient and hold the Shift button while pressing the down arrow this 
will select all the patients in the list as below. 

 

Now click on the Export button and in the export dialog box click on the browse 
button and find the folder and enter the name of a new file to create.  You can 
also add an optional comment in the WardWatch eXchange file.  This is 
displayed when the file is import into WardWatch desktop at a later time 
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Clicking OK will then create a file in the C:\Temp directory called Ward3_23-
Apr.wwx.  The file will have an icon showing that it is a WardWatch eXchange 
file and extension .wwx.  Double clicking on this file will trigger WardWatch and 
the import dialog box. 

Importing patient records is very straight forward.  It is recommended that 
before importing the Save button (or File > Save) is clicked on.  This will allow 
easy rollback if the wrong file is imported.  To import either the WardWatch 
eXchange file (.wwx) is double clicked on or the Import button on the 
WardWatch desktop is clicked. 
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Choose to import the “WardWatch eXchange” format and click OK, then click Browse 
to choose the name of the .wwx file to import.  Finally you can choose to either use the 
categories in the WardWatch eXchange file or import all the new patients into an 
existing category. 

 

Before importing the patients the number of patients found in the file and the optional 
comment are displayed. 

Reverting.  If the wrong file is imported or there is an error in the file.  Click on File > 
Revert to revert to the last saved patient record database. 

Archiving patient records is achieved by selecting the patients to archive.  
Exporting these patient records then deleting the patient records.  The patient 
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records in this file may be reload into WardWatch at anytime later using the 
import facility. 

 

Importing Patient Records from Hospas 

WardWatch can import patient records from the HOSPAS patient record system used 
in many Australian hospitals as follows. 

In order to import patient records from HOSPAS you will need to have WardWatch 
desktop loaded onto the same machine that has access to HOSPAS.  Typically 
HOSPAS is accessed via Telnet or a terminal emulator. 

1. Open Hospas and bring up the list of patients you which to import . 
2. Using the window to Hospas select the patient records and click Edit and copy 

from this window. 
3. Open Notepad on your machine (Start > Run > Notepad or Start > Programs > 

Accessories > Notepad) 
4. Cut and paste from Hospas just the patient records into notepad as shown 

below  
 

 
 

5. From Notepad select File > Save As and choose a temporary filename 
for import.  EG c:\temp\hospas.txt 

6. Go to WardWatch desktop as an optional step save any changes to the 
current patients by clicking File > Save.  This allows you to use the File 
> Revert if the import did not work according to expectations.  

7. From WardWatch desktop and import the new text based file.  In 
WardWatch select Import and Choose HOSPAS Patient Import 
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8. Choose the temporary file and choose the European date format 
 

 
 

9. Choose the category into which these records are to be import and click 
OK. 

 
Notes 
 

a) Before finally import you will be informed how many patient records 
have been found, warned of any errors. 

b) You may use the File > Revert menu option to revert to the last saved 
set of patient records.  For this reason it is a good idea to save any 
changes before the patient records before importing.  Note that closing 
WardWatch desktop or Hotsyncing will automatically cause any 
changes to be saved. 

 
 

Modifying Hotsync Behaviour 

If you decide you don’t require the patient export feature of WardWatch and you wish to 
minimize the time it takes to hotsync your Palm you can disable the export mechanism. 
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With the Hotsync manager running, right click on the hotsync icon in the System tray and 
select Custom from the menu.  Alternatively from the Palm Desktop, select the menu 
Hotsync and then the option Custom. 

 

 

 
This will bring up the actions that are currently performed each Palm user.  Choose 
your palm user, then select the line “WardWatch      Handheld overwrites desktop” and 
click Change.  Select the Do Nothing radio box and the Set as default checkbox then 
click OK.  Patient export will now be disabled for all further hotsyncs.  Select Handheld 
overwrites Desktop and select Set as default and click OK to re-enable. 
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Customization and Preferences 

Patients Preferences 

       

To change the preferences of the Patients, bring up the Options menu and tap 
Preferences. 

• Show Age & Sex: Check this option if you want the patient’s age and sex to be 
displayed in the Patients screen. 

• Show:  This preference determines what is displayed in the right hand column of 
the Patients screen.  The options are Consultant, Ward, Room/Bed, Record 
Number, or None 

• List By:  This preference determines the order in which patient records are 
displayed in the Patients screen.  The options are; Surname, Firstname or 
Consultant, Surname, or Room/Bed, or Ward, Room/Bed.   The options with 
two parameters indicate the primary and secondary sorting fields.  For example 
Consultant, Surname, ie the records are first ordered by Consultant and then by 
Surname. 

• IR Received Patient Category:  When receiving patients’ records by IR beaming 
you may place the received records into one of the following categories.   

o The Beamed Category, the patients’ records will be placed into the same 
category as on the sending Palm, the category will be created if necessary, 
if creating the category exceeds the Palm OS limit of 15 categories, the 
patient’s record will be placed in the Unfiled category. 

Chapter 
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o The Current Category, the patients’ records is placed in the current 
selected category.  If the selected category is All the record is placed in 
Unfiled 

o The Unfiled Category, the beamed patients’ records are placed in the 
Unfiled category. 

Patient View Preferences 

       

The fields in the “patient summary” in the Patient View screen may be customized 
using the Patient View Preferences.  There are currently two fields that may be 
customized. 

• Line 2, Field 1:   The default for this field is the Date of Birth (DOB).  If you prefer 
you can display the Room/Bed instead. 

• Line 2, Field 3:  The default for this field is the name of the consultant.  If you use 
the patient categories for the consultant’s name then it makes more sense to 
replace this field with the ward.  The options are Consultant or Ward. 

Setting up Patient Categories 

Before entering patient records into WardWatch, you may configure the categories 
that you would like to use for your patients. 

WardWatch uses categories to enable quick access and grouping of patient records.  
The use of categories is the same as the built in address book application.  Categories 
are also used for beaming or printing of groups of patient records. 

There are two standard ways in which categories can be used with WardWatch.  The 
“patient category” can be used for either the ward or the consultants’ name.  If you’re 
unsure what would be more efficient, don’t worry you, can change over at a later time.  
By default, WardWatch uses categories to record the ward your patients reside in. 

In the Patients screen, tap on All in the top right hand corner.  This will drop down the 
current list of categories.  Tap on Patient Categories… and you will be taken to the 
Patient Categories screen.  From this screen you can delete the example categories 
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and add the categories you would prefer to use for your own patients.  In the diagram 
below the example categories have been replaced by Ward names. 

       

 
Ward Categories 

If the category field is used for Ward (default) the other preferences should be as 
follows  

• Patients screen Preferences: Show: Consultant, List By: Consultant, 
Surname 

• Patient View Preferences: Line 2 Field 3: Consultant, Line 2 Field 1 either 

In this case ignore the ward field in the patient details. 

 
Consultant Categories 

If the category field is used for the Consultant 

• Patients screen Preferences: Show: Ward, List By: Ward, Bed/Room 

• Patient View Preferences: Line 2 Field 3: Ward, Line 2 Field 1: either 

In this case ignore the consultant field in the patient details. 

 
Other Patient Categories 

If you use the category field for another purpose, please email the authors of 
WardWatch so they can consider better ways of structuring the application. 
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Backup and Recovery 

Backup 

Standard HotSync provides backup of the WardWatch databases.  After performing a 
HotSync two database files will be present in your user’s backup directory on your 
PC’s hard disk.  If you installed the Palm Desktop software in C:\Palm, look for you 
databases in the following location. 

C:\Palm\<userdir>\Backup 

• WwPatientDB.pdb – this file contains your patient records in a binary format 
readable by your Palm Organizer. 

• WwEventDB.pdb – this file contains all the events for all your patients again in 
a binary format readable by your Palm Organizer. 

Note <userdir> = First six characters of the surname + the initial of the username for 
your Palm Organizer. 

You should also backup the WardWatch directory 

C:\Palm\<userdir>\WardWatch 

It is recommended that you take additional copies of these files periodically.  For 
example you may want to keep a copy of these files at the end of each week before 
deleting patient records from your Palm Organizer.  This will allow you to restore your 
database to any particular week. 

HOTSYNC YOUR PALM ORGANIZER FREQUENTLY TO AVOID LOSS OF DATA. 

Recovery 

IMPORTANT.  Before recovery of the databases for WardWatch.prc, it is advisable 
that you make a copy wwPatientDB.pdb and wwEventDB.pdb from the backup 
directory to another directory for safekeeping.  The location of these files is described 
in the Backup section. 

Recovery of the WardWatch database is from the last HotSync or from a specific 
HotSync.  It is not possible to combine the records from multiple HotSync backups.  (if 

Chapter 
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you took copies of your databases on two different dates, you cannot merge the 
databases together). 

There are two ways you can recover the WardWatch records from your last HotSync. 

Complete Palm Recovery 

If you have had a hard reset of your Palm Organizer or flat batteries and have lost all 
data from your Palm device you can recover WardWatch and the databases as part of 
the standard HotSync.  The first HotSync after complete loss of data will load 
WardWatch, its databases and the license key. 

Recovery of the WardWatch Databases Only 

If you have accidentally deleted WardWatch and its records, or somehow loss the 
WardWatch records recovery involves installing the patient and event database files 
describe above.   

1. Make a backup of your wwPatientDB.pdb and wwEventDB.pdb files as described 
above. 

2. Use the Palm Install Tool to install WardWatch.prc, wwPatientDB.pdb, and 
wwEventDB.pdb. 

3. Tap on the WardWatch icon on your Palm Organizer, it will start with the 
Evaluation Expired form.  Tap on Enter Registration Key and enter the key you 
received when you purchased WardWatch.  
 
Note if you have not yet purchased WardWatch you will still have access to you 
patient records, but will be subjected to the Evaluation Expiry screen each time 
you start WardWatch. 

4. After confirming the patient records are up to date, set the hotsync conduit to 
“Handheld overwrites Desktop”  and perform a hotsync.  Confirm that the hotsync 
conduit settings reverted to “Sychronise Files” in the hotsync conduit. 

5. Reset your Preferences in the Patients screen and Patient View screens as 
desired. 
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WardWatch Desktop Import / Export 
Specification 

Introduction 

WardWatch 3.1 (WW) provides the facility to import and export patient and event data 
in a standard format. This format will not be the same as the format used to store WW 
data on Palm WW or Desktop WW but will be designed expressly for import/export.  

Data import/export is carried out by the WW desktop application. This application will 
be able to be invoked on the command line or in an interactive GUI mode. Only GUI 
import/export available in version 3.1.  Command line will be available in later releases. 

Import/export data will be in a format that can be read and written by both spreadsheet 
applications such as MS Excel (individuals) and DBMS such as Oracle (enterprises). 

A single import/export file holds both patient and event data. 

File Type 

The type for the import export will be .wwx and an icon will be associated with this 
allowing this to open WardWatch desktop on double click. 

Comma Delimited File Format 

WW import/export files will be in a comma delimited format. This means that: 

•  Fields are separated by the comma character (‘,’) 
•  Records are separated by the new line (‘\n’) character 
•  Fields are enclosed by double quotation marks (eg, “my field text”) 

 
Notes 

Import/export field data must not contain the double quotation mark. The single 
quotation mark (‘) should be used instead. If data which contains double quotation 
marks is exported from WW, all double quotation marks will be replaced by the single 
quotation mark 

Appendix 
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Fields which contain commas or new line characters must always be enclosed in 
double quotation marks. Fields that do not contain commas or new line characters 
may optionally be enclosed in double quotation marks. 

The new line character used to separate records can be either Mac, Windows or Unix 
format. This means that it can be either ‘\n’, ‘\n\r’ or ‘\r\n’. All these new line character 
combinations will be treated in the same way. 

# as the first character of a newline where a new record is expected will indicate that 
this line is to be treated as a comment. 

Record Types and Fields 

There are two types of WW data records – event records and patient records. The first 
field of a patient record always contains a ‘P’ and the first field of an event record 
always contains an ‘E’. 

Header Record 

The first line of the wwx file is a mandatory header line indicating the version of the 
wwx file.  The first line must appear exactly as below. 

#Version: 3.1 

Comment Record 

The second line of the wwx file is an option comment that will be displayed during the 
import process of a wwx file.  It contains information related to the file.  The comment 
may be one or more lines.  If the comment is multiline it must be enclosed in double 
quotations.  “”.  The comment line must contain #Comment: as the first characters if 
WardWatch desktop is required to display the comment. 

#Comment: "Dear Dr. Phillips  
This file contains patient records from last nights round." 

Patient Records 

The patient record fields are as follows: 

Field Name Field Type Field Notes 
Type indicator char(1) Indicates if this record is a patient or an event. Always 

P for a patient record 
Local ID int This ID is unique within the file. If present, it is used 

link events with patients. It will be the ONLY primary 
key in version 3.1. 

MRN text Medical record number for the patient. If present, 
forms part of primary key for patient. 

Surname text If present, forms part of primary key for patient. 
First name text If present, forms part of primary key for patient. 
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Date of birth date If present, forms part of primary key for patient. (yyyy-
mm-dd) 

Sex char(1) M (male) or F (female) 
Admit date date Must be later than 1/1/1970 (yyyy-mm-dd) 
Bed text  
Ward text  
Consultant name text  
GP/MD name text  
Note text  
Diagnosis text  
Allergies text  
Code text  
Category text Patient category 

 
Bold = mandatory Underline = primary key 

Below is an example record (should all be on one line): 

“P”,”21341”, “52-34-55-2”,“Smith”,“Miranda”,“1981-4-20”,“F”,“2002-5-
13”,“7”,“Northwest”,“Fredricks”,“Francis J”,“bad 
lacerations”,“Cellulitus”,“shellfish”,“FCE” 
 
Event Records 

The event record fields are as follows: 

 
Field Name Field Type Field Notes 
Type indicator char(1) Indicates if this record is a patient or an event. 

Always E for a event record 
Local ID of Patient int This ID is unique within the file. If present, it is 

used link events with patients. It will be the 
ONLY foreign key used in version 3.1. 

MRN text Medical record number for the patient. If 
present, forms part of primary and foreign key 
for event. 

Surname text If present, forms part of primary and foreign key 
for event. 

First name text If present, forms part of primary and foreign key 
for event. 

Date of birth date If present, forms part of primary and foreign key 
for event. 

Create date date Date that the event was created. Forms part of 
the primary key for the event. (yyyy-mm-dd) 

Event date date Date that the event occurred. Forms part of the 
primary key for the event. (yyyy-mm-dd) 

Event time time Time that the event occurred. Forms part of the 
primary key for the event. (h:m [24h]) 

Test text Forms part of the primary key for the event. 
Result text  
Note text  
Status text Status of the event (eg, complete, start, end etc)
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Type text Type of event (eg, pathology, medication etc) 
 

Bold = mandatory Underline = foreign key to patient table 

Below is an example record (should all be on one line): 

“E”, “21341”, “52-34-55-2”,“Smith”,“Miranda”,“1981-4-20”,“2002-01-
21”,“2002-01-21”,”15:25:42”,”VitD”,”27 (42-
169)”,””,”Abnormal”,”Pathology” 

 

Import Notes 

In version 3.1, only new patient and event records will be created.  It is not possible to 
update and existing patient or event record.   

Export Notes 

Patient records are placed before their event records  
Any double quotes in field data are replaced by single quotes.  
DOS format (“\r\n” as new-line markers) will be used.  
All fields will be placed within double quotes. 

Sample Data 

#Version: 3.1 
#Comment: "This is the comment Line1 
Line 2 of the comment!" 
"P","1","0544512","Andrew","Anna","1916-8-31","F","1999-5-
24","23","3","Baker","Joseph874541877","","","","","Ward 3" 
"E","1","0544512","Andrew","Anna","1916-8-31","1999-6-2","1999-6-2","14:49","Rehab","","","In 
Progress","Consult" 
"E","1","0544512","Andrew","Anna","1916-8-31","1999-5-31","1999-5-
31","0:0","Euc","131/3.2/91/31/7.5/",".07/c2.42/p.76/m.66","Normal","Pathology" 
"E","1","0544512","Andrew","Anna","1916-8-31","1999-5-28","1999-5-
28","0:0","Neurology","Labyrinthitis","","Normal","Consult" 
"E","1","0544512","Andrew","Anna","1916-8-31","1999-5-27","1999-5-
27","0:0","Euc","122/3.3/86/26/4.4/","0.06/c2.24/p.62/m.65","Abnormal","Pathology" 
"E","1","0544512","Andrew","Anna","1916-8-31","1999-5-27","1999-5-27","0:0","Ct 
head","Subarachnoid cyst","","Normal","Radiology" 
"E","1","0544512","Andrew","Anna","1916-8-31","1999-5-25","1999-5-
25","0:0","Echo","AR","","Abnormal","Radiology" 
"E","1","0544512","Andrew","Anna","1916-8-31","1999-5-25","1999-5-25","0:0","Digoxin 
level","","","Normal","Pathology" 
"P","2","0220345","Evans","Peta","1922-5-28","F","1999-6-
2","34","3","Carson","Rodgers","","","","","Unfiled" 
"E","2","0220345","Evans","Peta","1922-5-28","1999-6-3","1999-6-3","15:35","Echo","LU mod 
dil","EF 15 mod - sev dysfuc","Abnormal","Radiology" 
"E","2","0220345","Evans","Peta","1922-5-28","1999-6-3","1999-6-
3","13:35","AbG","7.41/33/63/21","O2 sat93","Abnormal","Pathology" 
"E","2","0220345","Evans","Peta","1922-5-28","1999-6-3","1999-6-3","13:34","AncA","","","In 
Progress","Pathology" 
"E","2","0220345","Evans","Peta","1922-5-28","1999-6-3","1999-6-3","13:34","ds DNA","","","In 
Progress","Pathology" 
"E","2","0220345","Evans","Peta","1922-5-28","1999-6-3","1999-6-3","13:33","Esr","","","In 
Progress","Pathology" 
"E","2","0220345","Evans","Peta","1922-5-28","1999-6-3","1999-6-3","13:33","Rheumatoid 
factor","","","In Progress","Pathology" 
"E","2","0220345","Evans","Peta","1922-5-28","1999-6-3","1999-6-3","13:33","ANA ","","","In 
Progress","Pathology" 
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"E","2","0220345","Evans","Peta","1922-5-28","1999-6-3","1999-6-3","13:32","C 
rp","4","","Normal","Pathology" 
"E","2","0220345","Evans","Peta","1922-5-28","1999-6-2","1999-6-
2","11:26","Physio","Spirometry","","ToDo","Consult" 
"E","2","0220345","Evans","Peta","1922-5-28","1999-6-2","1999-6-
2","11:26","Macrodantin","","","End","Medication" 
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Evaluation Version 

Evaluation LimitationsEvaluation LimitationsEvaluation LimitationsEvaluation Limitations 

The evaluation version of WardWatch is the full version of WardWatch but with the 
limitations below imposed.  These restrictions are removed by entering the 
Registration Key. 

• After 30 days WardWatch on the Palm will have a 10 second delay during startup.  
This delay only occurs at startup and does not have any other effect.  You may 
delete WardWatch and reinstall it to obtain a further 30 day evaluation. However, 
this also means deleting the patient records currently stored with WardWatch.  

• You will not be able to create more than 15 patients.  You can delete existing 
patients and create new ones, but whilst using the evaluation version you are 
restricted to 15 patients. 

• You cannot beam, print or delete categories or multiple of patient records.  You 
can beam or print a single patient, but not an entire category. 

• Recovery of your patient database from backup will result in the immediate expiry 
of the evaluation version.  You are able to recover your patient records, but will be 
subject to the 10 second delay at startup. 

These restrictions are all removed once you have purchased WardWatch and entered 
the registration key. 

Appendix 
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Software User License Agreement 
 

YOU SHOULD CAREFULLY READ THE FOLLOWING TERMS AND CONDITIONS 
BEFORE USING THIS PRODUCT.  IT CONTAINS SOFTWARE, THE USE OF 
WHICH IS LICENSED BY TORLESSE SYSTEMS PTY LTD ("TORLESSE 
SYSTEMS"), TO ITS CUSTOMERS FOR THEIR USE ONLY AS SET FORTH 
BELOW.  IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS 
AGREEMENT, DO NOT USE THE SOFTWARE, USING ANY PART OF THE 
SOFTWARE INDICATES THAT YOU ACCEPT THESE TERMS AND CONDITIONS. 

LICENSE:  Torlesse Systems Pty Ltd (ACN 003 291 085), grants you a nonexclusive 
license to use the accompanying software ("WardWatch") subject to the terms and 
restrictions set forth in the License Agreement.  You are not permitted to lease or rent 
(except under prior written agreement with Torlesse Systems), or sublicense the 
Software or to use the Software in a time-sharing arrangement on more than one 
device (computer) or in any other unauthorized manner.  Further, no license is granted 
to you in a human readable code of the Software (source code).  Except as provided 
below, this License Agreement does not grant you any rights to patents, copyrights, 
trade secrets, trademarks, or any other rights in respect to the Software. 

You are expressly not permitted to distribute the Registration Key that is provided 
when purchasing the Software or may be provided by Torlesse Systems to you for 
promotion purposes.   The Registration Key is used to fully enable the product 
("Registered Software version") and may only be used on one(1) Palm Organizer and 
one (1) PC.   

You may distribute the evaluation version of the Software WITHOUT the Registration 
Key on the condition that this License Agreement is distributed with the evaluation 
version of the Software. 

The evaluation version of the software provides a 30 day trial.  If you continue to use 
the Software after that period to track patients you are required to purchase a 
registration key.  If you require a further 30 days usage for trial purposes only, you are 
permitted remove the Software and reinstall it. 

NO REVERSE ENGINEERING:  Modification, reverse engineering, reverse compiling, 
or disassembly of the Software is expressly prohibited.  

TERMS AND TERMINATION:  This License Agreement is effective until terminated.    
It will terminate immediately if you fail to comply with any term or condition of this 
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License Agreement.  Upon such termination you agree to destroy the Software, 
Documentation, Registration Keys, and any copies. 

GOVERNING LAW:  This License Agreement shall be governed by the laws of the 
state of New South Wales, Australia.  You agree that the United Nations Convention 
on Contracts for the International Sale of Goods (1980) is hereby excluded from 
application to this License Agreement. 

DISCLAIMER OF LIABILITY:  This software is provided "AS IS", without warranty of 
any kind, including merchantability, or fitness for a particular purpose.  After evaluating 
the Software, you must take the responsibility for deciding whether it is suitable to your 
purposes. 

Torlesse Systems Pty Ltd, endeavors to provide software of the highest performance 
and reliability, but accepts no responsibility in the event of a defect in the software.  
Should a defect arise you, and not Torlesse Systems Pty Ltd, assume the entire cost 
of any service and repair that may be required. 

Torlesse Systems Pty Ltd, assumes no responsibility for any damages, loss, injury, or 
death caused by deletion or corruption of data caused by malfunction, or failure of the 
Software.  Be sure to protect patient records against theft and backup records onto 
other media to protect against data loss. 

SERVERABILITY:  In the event that any provision of the License Agreement is found 
to be invalid, illegal, or unenforceable, the validity, legality and enforceability of any of 
the remaining provisions shall not in any way be affected or impaired and a valid, legal 
and enforceable provision of similar intent and economic impact shall be substituted 
therefore. 

Torlesse Systems Pty Ltd (ACN 003 291 085) 

YEAR 2000 COMPLIANCE: WardWatch is Y2K compliant.  WardWatch uses the 
Palm OS for date calculations and hence is dependent on the compliance of the Palm 
OS.   Palm Computing states that the Palm Organizers are Y2K compliant on the 
following web page. 

http://www.palm.com/custsupp/helpnotes/palmapps/year2000.html 
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